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Block 2: Analysing one variable Interval and ratio variables
2.2.1.2 [BSA86] Exercise - Reading in data for interval variables [4 December 2010]

Previous session: 2.2.1.1 [myclass] Tutorial and work-through - Frequencies

Exemplar: British Social Attitudes (1986 survey')

Research question:

What is the distribution of the number of people in a household, including the respondent?
What is the average number of persons per household?

What is the age distribution of the sample and what is its average age? What shape does
the distribution have? Where are the cutting points for the oldest 10% and 25% and the
youngest 10% and 25%7?

Task: 1: Read in raw data for number of people in a household and age of the respondent.

2: Save contents of data editor in a *.sav file and of syntax editor in a *.sps file.

File: bsa86.txt  (raw data from the 1986 British Social Attitudes survey)

SPSS commands?® used:

TITLE

DATA LIST

EXECUTE

LIST

A bit of repetition won't hurt you and it's good for reinforcing what you've already learned, so we're
going to do this from scratch on the raw data.

! Data files and user documentation obtainable via the UK Data Archive at Essex University as SN 2315. See
http://www.data-archive.ac.uk/findingData/snDescription.asp?sn=2315 for details and conditions for access.

2 General formats:

TITLE '<Any text>' .
DATA LIST FILE = '<location and name of external data file>'
RECORDS = <number of records per case>

/ <record> <varname(s)> <column(s)> <varname(s)> <column(s)> ~ ~ ~
/ <record> <varname(s)> <column(s)> ~ ~ ~ .

EXECUTE . [Executes all pending operations.]

LIST /CASES <n>.


http://www.britsocat.com/Body.aspx?control=HomePage
http://surveyresearch.weebly.com/uploads/2/9/9/8/2998485/bsa86.txt
http://www.data-archive.ac.uk/findingData/snDescription.asp?sn=2315

First we need to look at the questionnaire to find the relevant questions and know where to find the
appropriate data. Below is a facsimile extract from page 43B of the interviewer-administered®
guestionnaire which has all the information we need.

- 438 -
SECTION NINE .
ASK ALL —_— ::up
113.a)| Finally, a few questions about you and your household. Including
yourself, how many pecple live here regularly as members of this 1506-7)
household? INTERVIEWER: CHECK INTERVIEWER MANUAL FOR DEFINITION
OF HOUSEHOLD IF NECESSARY. P10
WRITE IN:
b)| And can I just check your own marital status?
At present are you ... READ OUT ... ..+ married, 1
living as married, 2
separated or divorced, 3
widowed, 4
or - not married? 5
114. Now I'd like to ask for a few details about each person in your house-
hold. Starting with yourself, what was your age last birthday?
WORK DOWN COLUMNS OF GRID FOR EACH HOUSEHOLD MEMBER.
Hesp- 7 8 9
ondent] 2 3 4 5 6
1511 | 1515 | 1520 | 1525 | 1530 |1535 | 1540 J154S | 1550
a)] Sex: Male| 1 1 1 1 1 1 1 1 1
Female | 2 2 2 2 2 2 2 2 2
1512-3hs16=70521~ =715 31=2hs36=7nsu1=2hsuE=TNN551=2
b)| Age lastbirthdayi | I
=1 =
Look closely at Q.113a)
~ 43B -
ASK ALL SECTION NINE Col./
Ca=llaai B s Code
113.a)| Finally, a few questions about you and your household. Including
yourself, how many pecple live here regularly as members of this CARD 15
household? INTERVIEWER: CHECK INTERVIEWER MANUAL FOR DEFINITION
QOF HOUSEHOLD IF NECESSARY. Fiocny
WRITE IN: [

The number of persons in the household is asked in

question 113a) and the reply is to be written in as a 2-digit .
number (with leading 0 or blank for fewer than 10 persons) WRITE IN:

Plboa-‘nl
1

to be punched in columns 8-9 of card 15 (there's a small
(1508 - 9) in the margin)

Similarly the age of the respondent last birthday is asked at
question 106b) and is entered as a 2-digit number to be
punched in columns 12-13 of card 15 (1512 - 3 in margin) b)| Age last birthday s

15123}

Without a lot of additional scripting or macro facilities not covered in this course, SPSS cannot
easily be made to read files from internet addresses. You will therefore need to download and save
raw data nd SPSS files from this site.

3

There were two versions of the interviewer administered questionnaire (with a common core) each covering a different

set of topics. This is from version B. Respondents also filled in a self-completion questionnaire to be collected later or
returned by post.
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Go to folder mybsa. If you have done the previous exercises your folder should look like this:

FEX
: File Edit View Favorites Tools Help -,’

\_’; @ - lﬁ /.__\J Search i Folders '

: Address |@ Ct\Documents and Settings\Owner\Desktop\mybsa v| e

& mybsa

3
S,

—;—J mybsaga
|

File and Folder Tasks R

=7 Make a new folder

&} Publish this folder to
the Web

[If you don't already have folder mybsa86, go back to the Block 2 menu and do exercises 2.1.2.3
to 2.1.2.7 and the housekeeping exercise 2.1.2.8.]

Double-click on mybsa86

B[=1[E3

I3

& mybsa86

: File Edit View Favorites Tools Help iy
i - 6 @, .

e Back </ lﬁ 7 Search | Folders

: Address |@ Ci'\Documents and Settings\Owner\Desktop'mybsaimybsage V| Go

3} ~ = bsags mybsada_1 E mybsada_1
File and Folder Tasks Text Document PASW Statistics Data Document Il PV Statistics Syntax File
) 3,304 KB 7KB po PN 1 KE
=7 Make a new folder
@ Publish this folder to mybsaga_2 E mybsada_2 E mybsada_freql
the Web PASW Statistics Data Documnent b PASW Statistics Syntax File . PASW Statistics Syntax File
{52 Share this folder 7KB »> L EE » L e

The full pathway name for the raw data file is:

‘C:\Documents and Settings\Owner\Desktop\mybsa\mybsa86\bsa86.txt'
which is quite long, but it's the best solution. When you need it for SPSS you only have type the
pathway in once (or you can also copy and paste it from here).

Work-through exercise

External data file 'C:\Documents and Settings\Owner\Desktop\mybsa\mybsa86\bsa86.txt"' has
23 records per case.

Write a set of SPSS commands to read in the number of persons from interviewer questionnaire
Q105a (record 15 columns 8-9) and age of respondent from Q106b (record 15 columns 12-13).
There are no missing values for number of persons in the household, but code 99 has been entered
where age has been refused or is not known. Use the positional convention for variable names
and specify missing values and variable labels. Again, it helps to prepare a table with your variable
names and locations: the question number and summary question text can also be used later as
variable labels.

Question Record Variable Start End
number name column  column

Q105a Persons in household 15 v1508 8 9

Q106b Age of respondent 15 v1512 12 13


http://surveyresearch.weebly.com/block-2-analysing-one-variable.html

Open SPSS:

i3 PASW Statistics 18

PASW Statistic;// _
| B

\hat would you like to do?

% @ open an existing dta source

Wore Fles...
CiiDacuments and Settings\OvinerDesktopieehly wel

@ Run the tutorial

© Type in data

1 D

% © open anather type of file

More Files...

© Run an existing query

© cCreste new guery
using Datahase Wizard

xgOF

[ Dont show this dislog in the future

.. and click Cancel to display a blank Data Editor (behind this pane). It will be called gSlgiifi[Elekl.

If it opens in Data View

£ Untitled1 [DataSntO] - PASW Statistics Data Editor M=1E3
File Ed' Wiews Data Transform  Analyze Graphs  Utiities  Add-ons  Window  Help

H%--«« PELYELEY

| |visible: 0 of 0 Variables

I — ,

Data View || “ariahle ‘iew:

| |PASW Statistics Processor is ready | | | | |

. click on Variable View in the bottom left corner to display it in Variable View  (this one has
been adjusted by shrinking it to three rows):

%58 Untitled1 [DataSPtO] - PASW Statistics Data Editor,

File  Edcit “iew Data Transfortn  Analyze  Graphs  Uilities Add-ons  Window  Help
==
SR % W -~ W= 8 B B
| Mame || Type " Width || Decimals " Lahel " “alues || issi
| | |
[ 2 ]
R
1

Data Yiew' | Variable View

| |PASW Statistics Processor is reacy | | | | |

Like the magician's black velvet bag, you can see it is empty on both views.

For most exercises, but not all, we are going to use SPSS in syntax mode in preference to drop-
down menus with point-and-click, so we need to write out a set of commands which SPSS can then
execute. For long and complex jobs we could do this in MS Word (or in a .txt file using other word-
processing software, and then drag the text into SPSS, but it's easier for very short jobs to do it
inside SPSS using the syntax editor.



Look in the top left corner of the Data Editor where you will see File. Open a new SPSS syntax
editor by clicking on:

File > New > Syntax

sit Untitledd [DataSet0] - PASW Statistics Data Editor

File  Ecit “iew Data Transform  Analyze  Graphs  Uiities  Add-ons Window  Help
hlewy | Eoats E % n ﬁ F’ B ,’3‘7 E
Cpen 3 B F_é
= syniax —
Open Databsase 4 - als || Lahel || Yalues || Missing
Quiput
[} Read Text Data...
2] Script
B ciose Cirl+F4 -
E Save Cirl+Z
e s —_—
B ==ve 21 Data
i; Export to Databaze. . |PAS‘IN Statistics Processor is ready | | | | |

... to display a blank syntax editor:

£= PASW Statistics Syntax Editor
Fie Edt View Data Transform Analyze Graphs Utiities Add-ons Run  Tools Window  Help

FHOOMB M ==
3 ‘
[ —— [+ a
T PASW Statistics Processorisready | | |Ln1 Cold | |NUM |

Before reading on, try writing out the syntax in the space below for TITLE and DATA LIST

Don't forget the primes and full stops!

title

data list

execute .



Work-through exercise

Using the right hand pane give your job a title (any text in primes) and type it into the syntax editor:

title

‘Data for interval variables (BSA 1986)' .

E= *Syntax1 - PASW Statistics Syntax Editor

File

Edit  View

Data

Transform

Analyze  Graphs

Utilities  Add-ons

Run T

oolz  Window  Help

SR M e ~

&%ﬂﬂb.\@\«é%%

lboiiimw

title

I:

=

1 b title
o}

‘Data for interval variables (BSA 1986) |

[ATH]

|PASW Statistics Processor is ready |

[ Intcorsz | [num|

Don't worry about the colour change for the TITLE command. Release 18 of SPSS now uses
colour coding for commands, subcommands and keywords. This is very helpful as we shall see.

Using the positional convention for naming variables, write a DATA LIST command to read the
data for number of persons in the household and age of respondent from external file:
'C:\Documents and Settings\Owner\Desktop\mybsa\bsa86.txt'

data list

records 23
/15 v1508 8-9 v1512 12-13.

£= *Syntax1 - PASW Statistics Syntax Editor

file 'C:\Documents and Settings\Owner\Desktop\mybsa\mybsa86\bsa86.txt’

File:

View Data

Transform

Analyze  Graphs

Utilities ~ Add-ons

Run  Toole Window Help

w.mdlﬁﬁ%ﬂﬂbt@\«él%ﬁ

I.Oi:imm—

title
data list

title

Idata list

1
2
i3
4
- b

=

‘Data for interval variables (BSA 1986) .
file 'C:\Documents and Settings\Owner\Desktopimybsaimybsad6\bsadb txt’
records 23
M5 w1508 8-9 w1512 1213 .

|PASW Statistics Processor is ready | |

[mscoln]

[hum |

[Note the colour coding for the keywords]

As you type, or if you make a syntax mistake, SPSS will display part or all of the text in red in the
syntax pane until the command is complete and ends with a full stop (period).

When you are happy with your command syntax, click on Run > All

E= *Syntax1 -

PASW Statistics Syntax Editor

File

View Data

Transform

Analyze  Graphs

Utilitiee ~ Add-ons

Run  Toolz Window Help

OE RN

-l It
P selection Cirl<Rt
IOOii M oo bosseo ) S
Step Through 3
1 title ‘Data for interval varial - S
data list 2 data list  file 'C:\Documents @ continue S
i3 records 23 Active DataSet 3
i M5 w1508 8-9 w1572 12-13°
==

psa\mybsadBibsadt txt’

[an

|PASW Statistics Processor is ready | |

[In4coi33]

[ |

. or highlight the whole text:



ES *Syntax1 - PASW Statistics Syntax Editor =163

File Edt View Data Transform Analyze Graphs Utiities Add-ons Run  Tools Window  Help

= 0 = ~ & E
..0‘!- Active: Data.SetﬂV

title
data list

1 P D =

[ [PASW Statistics Processorisready | | [mn4col33[  [num[

. and run the job by pressing [CTRL]+R or by clicking on the green » icon in the toolbar.

[If you make any non-syntax mistakes, SPSS will display one or more error messages in the output
file. Do not print your results if this happens. Try to work out what caused the error (usually
the first one reported causes all or most of the others). Close the output file without saving it, go
back and edit your syntax file and run it again. A new output file will be generated with an
incremental number (ie if the first output file was called outputl.spo, the new one will be
output2.spo and so on).]

The SPSS syntax commands for title and data list are repeated and SPSS tells you what variables
it is about to read and where it expects to find them. The output file will repeat your syntax and will
also display the way it has been interpreted. The output viewer will display:

title 'Data for interval variables (BSA 1986)' . |

>> Data for interval variables (BSA 1986)

data list file 'C:\Documents and Settings\Owner\Desktop\mybsa\bsa86.txt'
records 23
/15 wv1508 8-9 v1512 12-13

Data List will read 23 records from C:\Documents and
Settings\Owner\Desktop\mybsa\mybsa86\bsa86.txt

Variable Rec Start End Format
v1508 15 8 9 F2.0
v1512 15 12 13 F2.0

This is a useful check, especially when using the positional naming convention” as the variable
names should tally exactly with the record number and start column as in the display above.

If you bring up the SPSS Data Editor again you will see the name has changed to g8ljitif=lef2

£ "Untitled2 [] - PASW Statistics Data Editor
File Edit Wiew Data Transform Analyze Graphs Utiities Add-ons  Window

ErT Y IR N LT N

- EEE P E)

| Name || Type ” Width ” Decimals H Label ” Values ” Missing ” Columns ” Align || Measure ” Ri
1 }HSUB |Numenc 2 0 MNone None T = Right Unknown A’ Inp
2 v1512 Numeric 2 0 MNone None T = Right Unknown S Inpl_|
1 3
e

i [PASW Statistics Processoris ready | | | | |

Your own variable names are displayed in the Name column together with, in the other columns,
various technical information about them. [NB: Measure is "Unknown" because the data have not
yet been read in.]

4 See 1.3.1 Conventions for Naming Variables in SPSS



http://surveyresearch.weebly.com/uploads/2/9/9/8/2998485/1.3.1_pdf_conventions_for_naming_variables_in_spss.pdf

Click on Data View

£i “Untitled? [] - PASW Statistics Data Editor (=13
File  Ecit ‘“iew Data Transform Analyze Graphs LUtilities Add-ons  Window  Help

SHé Il - e B R 5 B i 0% “6

| [visible: 2 of 2 Variables

I| 1503 ||| vz | \I | | | | \I | | | L

4

Data View || Yariahle Yiew:

| |PASW Statistics Processor is reacy | | | | |

D

The names of the two variables you are about to create ( v1508 and v1512 ) appear in the headers
of the first two columns, but there are no actual data. Do not panic! SPSS hasn't yet read the raw
data. It only actually makes a pass through the data when asked to perform some sort of analysis
or when given a special EXECUTE command.

EXECUTE

The EXECUTE command forces SPSS to read the data without waiting for a statistical command.
Go back to your syntax editor and type:

execute .

E *Syntax1 - PASW Statistics Syntax Editor

File View Data Transform Analyze Graphs Utiities Add-ons  Run  Toole  Window  Help

S REHIAN PO 00 s B =
IOOiilmm

1 title ‘Data for interval variables (BSA 1986) . =
data list 2 data list  file 'C:\Documents and Settings\Owner\Desktop\mybsa\bsag6 txt’
execute I3 i records 23
4 /M5 v1508 8-9 w1512 1213
g P execute .
- -

[ |PaSW Statistics Processorisready | | [nScolo | [NUM | i

Click on the green » to run the command:

In the data editor the previous "Unknown" levels of measurement in the Measure column will
change to "Nominal" for v1508 and to "Scale" for v1512.

23 *Untitled? [] - PASW Statistics Data Editor
File Edit View Data Transform Analyze Graphs Utiites Add-ons  Window  Help

SHe @« ~ BiF 88 Bk BAEH 19%

| Name || Type || Width ” Decimals || Label || Values || Missing || Columns || Align || Measure ||
|v15[]8 |Numer|c 2 0 Mone MNaone 7 Right &5 Nominal “u IE

2 v1512 Mumeric 2 0 None MNaone 7 = Right & Scale |
1 [

Data View | Variable View

I |PasSw Statistics Processorisready | | | | |

But, you may ask, the number of persons in the household is an interval variable, so why isn't it
displayed as "Scale"? It's because SPSS has default settings for the number of unique values
found (in this case 7) before it declares them as "Scale", but v1508 has fewer values than the
default so it is left as nominal.



You can change the default settings for scale variables in SPSS from inside the data editor with Edit
> Options > Data, but it's easier for now just to click on the cell:

fif *Untitled? [] - PASW Statistics Data Editor

File Edit Wiew Data Transform Analyze Graphs Utities Add-ons  Window

SHe @l «~ FLE R E

Help

= 5L

I Name || Type ” Width || Decimals || Label ” Values ” Missing ” Columns || Align | Measure
1 V1508 Numeric 2 0 None None 7 = Right &b Mominal = [ ™ 1%
2 w1512 Mumeric 2 0 Mone None 7 = Right & Scale N =

] ol Ordinal 3
&> Mominal
e

[PASW Statistics Processorisready | | | | |

and change it by clicking on Scale

fif *Untitled? [] - PASW Statistics Data Editor

Fie Edit View

Data Transform Analyze Graphs Utiities Add-ons  Window  Help

O [ < -
SHe M« BHLFREBEE BLE 0%
I MName ” Type || Width ” Decimals || Label || Values || Missing || Columns ” Align || Measure ||
1 v1508 Murmeric 2 0 MNone Mone T = Right & Scale LY I
2 w1512 Murmeric 2 0 Mone Mona 7 = Right & Scale “u |
L] 2

Data View | Variable View

‘ |PASW Statistics Processor is ready | | | | |

Checking your data

Before proceeding to extend your data dictionary or do any statistical analysis, it is good practice to
check the actual data to see if they look like what you'd expect. Switch the data editor to Data

View and you will see that the first two columns have now been filled with data.

23t *Untitled? [] - PASW Statistics Data Editor

File  Edit “iew Data Transform  Analyze Graphs  Utilities  Add-ons  wWindow  Help
? D == =g ‘
SHe B -« ~ B, 8 BaE e
[1: v1508 1 [wistole: 2 of 2 varisbles
| visss | wisi2 | | \I | | \I | |
1 [ 1 80
2 3 B0 I 1
3 2 52
1 I¥]
==
| |PAS\N Statistics Processar iz ready ‘ | | ‘ |

If you scroll down the whole file (or more quickly press [CTRL]+[end] to go the end of the file) you
will see that there are 3,100 lines of data ie 3,100 cases.

£58 *Untitled2 [] - PASW Statistics Data Editor,

File  Ecit ‘iew Data Transform  Analyze Graphs  Uilties  Add-ons  Window  Help
: = = == @& ‘
SHae i « « Bl M Bl 49
[1: w1508 [1 [rvisible: 2 of 2 variables
| wvisos [ wisiz | | | | | | | |
3098 4 22 =]
3099 2 26 I
3100 2 B2
1 ¥
[ PAS\W Statistics Processor ks ready | | | ||




LIST
As a data check you can also use the LIST command [not available as a drop-down menu].

It has to be limited to a few cases, otherwise you will get a listing of all 3,100 lines of data. That's a
lot of trees if you print a hard copy!

list / cases = 10.

£ *Syntax1 - PASW Statistics Syntax Editor

View Data Tranzform Analyze Graphs Utiities Add-onz Run  Toole Window  Help

ERE D e SELE 0 P06 2 B B
[ELTL LN s

1 title ‘Data for interval variables (BSA 19386) . -
data list 2 data list  file 'C:\Documents and Settings\Owner\Desktop\mybsa\mybsag6i\bsadt b’
execute 3 I records 23
list 14 M5 w1508 8-9 w1512 1213 .

5 execute .

g P list /cases =10 .

-l =

| |Pasw Statistics Processor is ready | | [m&Col20|  [NUM | I

..and run the command by clicking on the green » icon. The output file will now display:

v1508 v1512

1 80

3 60

2 52

5 31

3 20

5 43

2 26

3 37

4 48

2 49
Number of cases read: 10
Number of cases listed: 10

Whilst not strictly necessary for this exercise, it's also good practice to get into the habit of regularly
saving your work as you complete each stage of file-building. Go back to the data editor and switch

to Variable View

£t *Untitled2 [] - PASW Statistics Data Editor
File Edit Wiew Data Transform Analyze Graphs Utiites Add-ons  Window  Help

SHellec~ B R B BAEH 1009 %

| Name " Type " Width " Decimals " Label " Values " Missing " Columns || Align " IMeasure " Ri
1 v1508 Numeric 2 0 None None 7 = Right & Scale A" Inp
2 v1512 Numeric 2 0 None None 7 = Right & Scale A" Inp
=

Variable View

i [pasw Statistics Processorisready | | | | |
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Click on File > Save As ..

£if *Untitled2 [] - PASW Statistics Data Editor

File Edit View Data Transform Analyze Graphs Utiities Add-ons Window Help

: aNGEE N |

Open

=F a9 W 5

Open Database b | Width " Decimals ” Label ” Values ” I’\;I\sslng || Columns ” Align " Measure || Ri
[ Read Text Data... 4 0 None Mone 7 ight & Scale A" Inp
8 cios- CirleFa P 0 Hone Mone 7 ight & Scale N Inp
i sove I IR -
Save As..
Fd Save AlData [PASW Statistics Processorisready | | | | |
Navigate to folder mybsa86 ... and write mybsa86 3 in the File name: box

it Save Data As

Look in: |&] mybsads > | ER Look in: |&] mybsads
E mybzads_1 .sa!| E myb=ads_1.sav
E myb=ads_2 =zav E myb=als_2.sav

Keeping 2 of 2 variables. Vari Keeping 2 of 2 variables.

File name: |Unt'rtled2 File name: |rrrybsaa€u_3|

-_"'m -_\J’anﬁhles
Save astype: [PASW Statistics (*sav) -] Save astype: [PASW Statistics (*sav) -]

Make sure the Save as type:  box displays [PASW Statistics (*.sav) | and click on

A copy of the data editor will be saved as mybsa86_3.sav in folder mybsa86.

& mybsa86

File Edit Wew Favorites Tools Help

@Bad( - .J I.E pSeardﬂ H__ Folders '

: Address |E} C:\Documents and Settings\Owner\Desktop'\mybsa\mybsags v| Go

b
— [Z bsagds mybsa8s_1 =] mybsags_1
&= | TextDocument PASW Statistics Data Document el SV Statistics Syntax File
3,304KB 7KB » 2. P
(29 Make a new folder
@ Publish this folder to L mybsads_2 E mybsads_2 E mybsads_freql
the Web PASW Statistics Data Document e PASW Statistics Syntax File e PASW Statistics Syntax File
{ed Share this folder KB ey e > L B
b %

File and Folder Tasks #

mybsa8s_3
PASW Statistics Data Document
7KB

Other Places

The data editor remains oien as the active file in SPSS, but the header will change from

*Untitled2.saviielbsa86 3.savj

ybsaB6_3.sav [] - PASW Statistics Data Editor
File Edit Wiew Data Transform Analyze Graphs Utities Add-ons  Window  Help

SHES M-~ XLABE

I MName ” Type || Width ” Decimals || Label || Values ” Missing || Columns ” Align ” Measure ” Ri
1 MSDS |Numeric 2 0 None None T = Right & Scale A" Inp
2 v1512 MNumeric 2 0 None MNone T = Right & Scale Y Inp
=

1 5

Data View  variable View

| |PA5W Statistics Processor is ready | | ‘ | ‘
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The output file will display the following syntax generated automatically by SPSS:

SAVE OUTFILE='C:\Documents and Settings\Owner\Desktop\mybsa\mybsa86\mybsa86 3.sav'
/COMPRESSED.

You should also get in to the habit of saving your file-building syntax. Good practice is to have the
same name as the *.sav file it creates, but with a *.sps extension, in this case bsa86_ 3.sps. Go
back to the syntax editor and click on File > Save As ..

£= "Syntax1 - PASW Statistics Syntax Editor

File Edit \iew Data Transform Analyze Graphs Utiities Add-ons Run Tools Window Help
o | REL R PO 0% e B
Open 3 A iz ﬂﬂ e =
Open Databazse L
- tive: Unnamed ~
[Z Read Text Data... -
(G0 Close ClriF4 = ‘Data for interval variables (BSA 1986) . -
- a list  file 'C:\Documents and Settings\Owner'\Desktop\mybsaimybsag6ibsadt bd
A save Cirlss records 23
Save As... M5 w1508 8-9 w1512 1213 .
Dizplay Data File Information 3 pcute .
- - /cases =10 .
o Stop Processor Cirl+-Period -
i Switch Server . |PASW Statistios Processorisready | | [m&coizo| [num|
Navigate to folder mybsa86 . and write mybsa86_ 3 in the File name: box:

E= Save Syntax As E= Save Syntax As

~] @ EEE s

Look in: |@ myb=als Look in: |E] myb=eads

. mybzads_1.zps
mybzadf_2 zps
mybsads_freql.sps

myb=ads_1.sps
myb=ads_2.=sps
mybsald8_freql.sps

File name: |5‘,rmax1 | | Save I File name: |m‘yb6536_3 | | Save I
Save as type: |S‘,rntax (*=ps) - | Save as type: |S‘,rntax (*.=ps) - |
Encoding:  [Local Encoding =] Encoding:  [Local Encoding -]

Make sure the Save as type:  box displays [Syntax (*.sps) | and click on

Your mybsa86 folder should now look like this:

& mybsa86

: Flle Edit View Favorites Tools Help

@Ead& < -J l-@ pSEBrch H__ Folders v

: Address |@ C:\Documents and Settings\Owner'\Desktop\mybsa'mybsads

bzage mybsads_1
Text Document PASW Statistics Data Document
3,304 KB T7KB

. ~ mybsad6_1
File and Folder Tasks = = PASW Statistics Syntax File
» 2 R

(9 Make a new folder

@ Publish this folder to
the Web

& Share this folder

mybsa3s_freql
e PASW Statistics Syntax File
» 2 s

mybsasa_3
PASW Statistics Data Document

mybsasa_3
PASW Statistics Syntax File
TKB b I, 1KB

Other Places

A a

= mybsads_2 mybsass_2
PASYW Statistics Data Document e PASW Statistics Syntax File
T7KB g 1B

2 &

12



The syntax editor header will have changed from dmybsas6 3.sps]

£2 mybsaB6_3.sps - PASW Statistics Syntax Editor
File  Edit Wiew Data Transform Analyze Graphs Utiities Add-ons Run Tools Window  Help

SEE M« ~ & TRAY LY E

‘6‘1 - Active: [Unnamed ~ |
title s

title ‘Data for interval variables (BSA 1986) .
data list data list  file "C:\Documents and Settings'\Owner'\Desktopmybsaimybsag6i\bsath bd’
execute I records 23
M5 v1508 8-9 w1512 1213 .
execute

P list /cases =10 .

1
2
3
list 14
5
B
-

-

|PASW Statistics Processoriz ready | | |mECol20|  [NUM |

The first editions of your SPSS data and syntax files are now safely stored for you to proceed to the
next stage. This will be to extend your data dictionary by adding MISSING VALUES, VARIABLE
LABELS and VALUE LABELS.

You can save the output file as well if you like, but you don't really need to as you can always run
the job again.

End of session
Next session: 2.2.1.3 [BSA86] Extending your data dictionary

[Back to Block 2 menu]
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